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About This Guide 

This guide provides information on how to use Benefitfocus® Billing & Payments (eBilling). Billing & 
Payments (eBilling) is an electronic invoice presentment and payment solution, securely hosted for you to 
ef f iciently manage and pay your invoices online. 
 
The chapters in this guide correspond to each of the tabs that appear in the main navigation bar on the 
lef t of each page of the Billing & Payments (eBilling) application. See Working with the Billing & Payments 
(eBilling) Home Page for additional information.  
 

 
Some features in this document may not be available to you, based on software settings 
established for your company and/or security-driven features within the application. Please 
contact your account representative if you have questions about your access. 

 
 
This document may include the following icons to highlight additional information, warnings and 
suggestions: 
 

 
The document icon references external documentation that is useful to further understand the 
information being presented. 

 

 
The note icon provides additional or important information about special conditions, 
suggestions or actions that should be taken. 

 

 
The risk icon is a warning, often cautioning against taking certain actions. 

 

 
The tip icon provides additional, more efficient instructions when completing a task. 
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Chapter 1 Billing & Payments (eBilling) Basics 

This chapter provides information on the basics of working with the Benefitfocus Billing & Payments 
(eBilling) application and includes information on logging into the application, working with the Billing & 
Payments (eBilling) user interface and managing your account information. 
 

Getting Started with Billing & Payments (eBilling) 
 
Depending on your configuration, you may either access eBilling via Single Sign On (SSO) from your 
existing Benefitfocus® eBenefitsNow or Communication Portal or you may login to the Billing & Payments 
(eBilling) application directly. Refer to the instructions provided below that are most appropriate to your 
situation. 
 

Logging in Directly to Billing & Payments (eBilling) 
 
Prior to accessing Billing & Payments (eBilling), you should be provided with a web address, username 
and initial password by your Benefitfocus Account Manager.  
 

 
If  you have the web address for the Billing & Payments (eBilling) site, but have forgotten your 
Username or Password, you may be able to use the links provided on the login page to 
retrieve your username or reset your password.  
 

 
 
 

  
You will need to have an email address on file for verification purposes to use the 
retrieval/reset feature.  
 
If  you have forgotten your username, you will be asked to provide the first name, last name 
and email address associated with the Billing & Payments (eBilling) account to help identify 
your account and then you will be required to answer a secret question to verify your identity. 
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If  you have forgotten your password, you will be asked to provide your username and pass 
the Security Check to identify your account. 
 

 
 
 
A 6-digit validation code to reset your password will then be sent to the email address 
associated with your Billing & Payments (eBilling) account. Note, the link is only valid for 15 
minutes af ter sending.  
 

 
 
You will be asked to enter the 6-digit validation code in the Billing & Payments (eBilling) 
screen to verify your identity before you may reset your password. 
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Complete the following steps to log into Billing & Payments (eBilling). 
 

1. Navigate to the Billing & Payments (eBilling) login page by entering the provided web address 
into your web browser address field: https://bcbsnc-shp.secureebilling.com/ 
 

 
If  you have not received, or if you have forgotten, the web address for the login page, please 
reach out to your Benefitfocus Account Manager. 
 

 
2. Enter your Username and Password in the fields provided. 

 
3. Click Log In. 

 

 
If  this is your first time logging in, you may be prompted to update your initial password and to 
enter secret questions and answers. See Updating Your Account - Email, Password and 
Secret Questions for password requirements. Your secret questions and answers may be 
used to verify your account in the case of a f orgotten username or password. 
 

 

Logging into Billing & Payments (eBilling) from eBenefitsNow 

 

If  you are a Benef itfocus eBenefitsNow client, you may be able to access Billing & Payments (eBilling) 
f rom your existing eBenefitsNow application. 
 

 
The option to SSO between Benefitfocus applications must be enabled for your organization 
by a Benef itfocus Administrator and your user account must be granted permissions to SSO to 
Billing & Payments (eBilling) to use this option. 
 

 
Complete the following steps to access Billing & Payments (eBilling) from the eBenefitsNow Benefits 
Administrator role. 
 

1. Log into eBenefitsNow.  
 
Prior to accessing eBenefitsNow, you should have been provided with a web address, username 
and initial password by your Benefitfocus Account Manager. If  these were not provided to you or 
you have forgotten the web address of your login page, please reach out to your Benefitfocus 
Account Manager. 

 
2. Click the application launcher  in the upper right hand corner the Benefits Administrator role.  

 
3. Select Billing from the drop-down menu that displays. 

 

 
 
You will be logged into your Billing & Payments (eBilling) application via SSO.  
 

  

https://bcbsnc-shp.secureebilling.com/
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Updating Your Account - Email, Password and Secret Questions 

 

Your account settings may include your email address, your account password and security questions. 
  

 
If  you SSO into Billing & Payments (eBilling), your login information may be maintained in a 
separate system and you will not have access to the My Account link. 

 

 
The email address on file will be used for any notifications sent from the Billing & Payments (eBilling) 
application and may be used for username recovery or password reset.  
 
Your password is used to access the Billing & Payments (eBilling) application and therefore must be 
considered personal and confidential. When creating or updating your password, your password must 
meet the following criteria: 
 

• 8 – 15 characters in length (special characters are permitted, but not required) 

• At least one uppercase letter 
• At least one lowercase letter 
• At least one number 
• No spaces 

• No more than 2 of the same characters in a row 
• Cannot contain your email or username 
• Cannot be the same as your previous password 

 
Security questions may be used for account validation in the future, if you lose your username or 
password. 
 
Complete the following steps to update your account settings. 
 

1. Click the user profile menu in the upper right corner, and then click the My Account link. 
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The My Account Settings page displays. 
 

 
 
 

2. Enter or update your preferred email address. 
 

 
Be sure to enter a valid email address. Notifications, such as when new invoices are ready 
for review, will be sent to the email address entered on this page. 
 

 
3. Update your password, if desired, by entering your current password in the Old Password field 

and then entering your new password in the New Password and Confirm New Password fields. 
 

 
Click the help icon next to the New Password field to view password requirements. 
 
 

 
4. Enter or update security questions as desired. Each secret question must be unique.  

 
5. Click Save. 
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Working with the Billing & Payments (eBilling) Home Page 

 

 

 
 
On the home page, you can access a number of the major features of the Billing & Payments (eBilling) 
application, including: 
 

• View your current invoices and invoice details 

• Make a payment 

• Print your current invoice 

• Viewing invoice details 

• Edit Email Address link 
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Using the navigation bar, available from all pages within the application, you can quickly navigate to any 
tab to access the functions you need. 
 

• Billing tab: Search for and view invoices with additional options to drill down into the invoice 
details, print the invoice or make a payment 
 

  
 

• Payments tab: Manage payment accounts and view payment history or pending payments 
 

 
 

• Reports tab: Create, schedule and view reports 
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The home page also includes additional sections for quick access to messages, delinquent invoices, 
payment history and account information and reports. 
 
 

 
 
 
 
 

• The Messages area displays important information and instructions. This may include system 
messages alerting you to any planned application downtime for maintenance or messages from 
your carrier. 
 

• The Payments area provides quick access to payment history, pending payments and payment 
account information. 
 

• The Scheduled Reports area provides quick access to the Scheduled Reports page and to 
creating new reports. 
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• The Edit Email Address link provides quick access to update the user’s email address 
 
 

 

 
 

 

 

 

Logging out of Billing & Payments (eBilling) 

 

To log out of Billing & Payments (eBilling), click the user profile menu in the upper right corner, then click 
the Logout link. 
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Chapter 2 Billing 

By default, your most recent invoices are displayed on the Home page. You can view additional invoices 
and invoice information on the Billing tab, which also enables you to search for invoices. 
 

 
 
 
 

Viewing Invoices 
 

The View Invoices page provides you with at-a-glance visibility into your invoices. This page provides a 
list of invoices meeting the entered search and filtering criteria along with high-level information such as 
 

• Invoice Level: Unique numbers identifying your account with the carrier 

• Invoice #: Unique number identifying the invoice 

• Due Date: The date payment is due for the invoice 

• Bill Date: The date the invoice was issued 

• Paid Thru Date: Date through which coverage has been paid 

• Billing Period: The coverage period for premiums billed on the invoice 

• Balance Forward: Any unpaid outstanding balance or credit from a previously billed invoice 

• Amount Due: Total amount due for the current billing period 

• Updated Amount Due: If  the invoice has been updated due to an adjustment or correction after 
original bill was issued 

• Invoice Type: Indicates if the invoice is for premiums due or if the invoice is for any interest 
accrued due to late payment  

 
By default, this page displays all Current invoices, but you may search for invoices by an invoice status 
and/or an invoice level (if applicable). The list can be sorted by any of the included details.  
 

 
You may perform a more advanced search using the options provided on the Search 
Invoices tab. See Searching for Invoices for more details. 

The list below provides a brief description of each invoice status: 
 

• Current: All invoices from the current coverage period that do not have a payment applied to them 

• Prior: All invoices from a previous coverage period and do not have a payment applied to them 

• Paid: All invoices that have payments applied to them 
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Searching by Invoice Level 
 
Invoice level may be used by groups who receive separate invoices for different groupings of members, 
such as per location or line of business. If a group is using invoice levels, an Invoice Level Search option 
will display at the top of the View Invoices page.  
 
Complete the following steps to view invoices for a specific invoice level or invoice group.  
 

1. Click the Billing tab on the navigation bar. The View Invoices page displays. The default display is 
all Current invoices, but you may select another status from the drop-down menu and click 
Submit to view. 
 

The Invoice Level Search is located at the top of the page. 
 
 
 

 
 

2. Enter the invoice level identifier in the Invoice Level Search field, shown here as Billing Entity 
(e.g. 141707421007).  
 

3. Click Submit.  
 

 
 
The search results display the available invoices for the entered invoice level/account number for the 
currently selected status type. 
 
 

2 

3 
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Viewing Consolidated and Sub-group Invoices 
 
Consolidated invoices contain multiple sub-group invoices rolled into an overall group invoice. Invoices 
are consolidated for convenience to display a summary of all the invoices for a particular billing period. 
Consolidated invoice records are identified by a plus symbol (+) adjacent to the invoice level name or 
number, as shown in the figure below. 
 
 

 
 
Click the (+) symbol to view the sub-group invoice information. The sub-group account number appears 
af ter the “/”. 
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Viewing Invoices by Status 

 
The default view on the View Invoices page displays Your Current Invoices. You can easily modify the 
invoice list view by selecting to view a different period or category from the View drop-down menu and 
then clicking Submit. You can display Current, Prior, Obsolete or Paid invoices. 
 

 
 
 
The modified view displays. 
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Viewing Invoice Details 
 
View the details of any invoice to access additional information, including financial totals, charges, 
retroactivity, adjustments and additional fees or charges. You can view the details of an individual invoice 
or consolidated/sub-group invoices. When viewing a consolidated invoice, Consolidated Invoice View 
displays in the header as a reminder. Depending on your arrangement with your carrier, you may also 
receive interest invoices. 
 

 
 
To view additional details for an invoice, click Options and select View Invoice for the invoice. 
 
 

 
The last column on the View Invoices page, Invoice Type, indicates if the invoice is an 
invoice for premiums due or an invoice for interest due. 

 
The Invoice Details page displays. Tabs located at the top of the page allow you to navigate to different 
sections of your invoice while buttons located at the top of each tab enable you to quickly jump to pages 
to pay or print your invoice. Summary details for the invoice are included as a header on each tab for 
reference, and may include the billing date, billing period, paid through date, due date and total amount 
due.   
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Invoice details and labels may vary depending on the settings established for your company. 
The following screens and descriptions are shown for sample purposes only. 

The Financial Totals tab provides a summary of total costs and adjustments since the last invoice, such 
as retroactive adjustments, any unpaid balance (balance forward), new premium or interest charges for 
the current coverage period and the total amount due. 
 
 

  
 
Click the Summary tab to view a breakdown of the members and cost per plan for the current period, 
retroactive values and combined. 
 

Invoice details 
navigational 

tabs 

Available invoice actions 
Invoice summary 
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Click the Details tab to view the roster of billed subscribers and additional subscriber information. This 
may include columns for information, such as subscriber ID, name, coverage dates, benefits package and 
coverage level. The table is searchable and sortable. 
 
If  the subscribers have dependents or multiple plans, the Expand/Collapse All buttons can be used to 
show/hide subscriber details.  
 
If  your group is also a eBenefitsNow client, you may be able to select View in Enrolment from the Options 
drop-down menu to the left of the member's name to view the employee’s record in the eBenefitsNow 
Benef its Administrator role. 
 

 
 
Click the Retroactivity tab to view the details of any retroactive adjustments that have been applied to the 
current invoice. The table may include columns for detail information, such as subscriber ID, name, 
coverage dates, product, coverage level and adjusted premiums. The table is searchable and sortable. If 
the subscribers have dependents or multiple plans, the Expand/Collapse All buttons can be used to 
show/hide subscriber details. 
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Click the Fees and Other Services tab to view the details of any fees that have been applied to the 
current invoice.  
 

 

 

Sorting Invoices 

  
You can sort the invoice list and some invoice details using the sort function on any column to display the 
records in ascending or descending order. 
 

 
 
Clicking on the top arrow sorts the invoice records in ascending order by the column content. 
 

 
 
Clicking on the bottom arrow sorts the invoice records in descending order by the column content.  
 

 
 
Click the column header name to remove the sort and display the default view. 
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 Advanced Sorting 

 
Some pages that display lists with information in multiple columns include an advanced sorting feature 
that enables you to sort data using multiple columns and save your sorting preferences. 
 
Complete the following steps to apply advanced sorting to your table. 
 

1. Click the Advanced Sorting button. 
 

 
 

 
The Advanced Sorting window displays. 
 

 
 

2. Select the criteria for the new sort order. 
 

3. Click View. 
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Af ter sorting the columns, an arrow displays in the column header to indicate whether the data is sorted in 
ascending or descending order. The column name also includes a number to indicate the sorting order. If 
you selected to subtotal the columns or include the grand total, the subtotal information will display within 
the results set. The grand total will display at the end of the results set. 
 

 
 
 
Depending on your search results, the data may display on multiple pages. You can use the navigation 
control at the bottom of the page to navigate to additional pages to see the total amounts. 
 

 
 
Af ter applying an advanced sort to a page, you can click the Reset Sort button on the page header to 
clear the selected criteria. 
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Saving and Applying Advanced Sorting Templates 

 

When selecting your sort criteria, you can also click Save as sort template to create a template of a 
f requently used sorting order to reuse in the future. 
 

 
 
Enter a name for the template and click Save. 

 

 
 
Your sort templates will then display in the Advanced Sorting window. To apply the sort criteria, click View 
for the applicable template. 
 
 
 
You can also click to Edit or Delete a sort template as necessary. 
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Searching for Invoices 
 
You can perform a more advanced search or locate a specific invoice by conducting a search using the 
Search Invoices page. 
 
Follow the steps below to search for invoices. 
 

1. Click the Billing tab on the navigation bar. The View Invoices page displays. 
 

2. Click the Search Invoices tab. The General Search page displays. 
 

 

 
 

3. Enter the search criteria. You may search by account number, search for invoices whose 
payment due date, billing date, paid through date or billing period fall within an entered date 
range, by invoice status, by invoice type or a combination of those search criteria. 
 

4. Click Submit to display the search results. 
 

 
 

2 

1 
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You can click the Search Criteria link above the table to view or update your search criteria. 

 
5. Click Options and select View Invoice to view the invoice details. 

 

 
 
The Invoice Details page displays for the selected invoice. See Viewing Invoice Details for additional 
information. 
 

 

Printing Invoices 
 
Complete the following steps to generate a printable version of your invoice. 
 

6. Use one of the following three options to print an invoice: 
 

• Click the Print Invoices button on the current invoice displayed on the Home page. 
 

 
 
 

• Click Options and select Print Invoice on the invoice displayed on the View Invoices page (for 
both consolidated and non-consolidated invoices). 
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• Click the Print invoice button on the Invoice Details page. 
 

 
7. Select the desired format to save/print your invoice from the drop-down menu. Options include 

PDF, CSV or HTML. 
 

8. Select which invoice details you would like to include. 
 

9. Select the desired sorting order for the roster if including Details or Retroactivity sections. 
 

10. Click Print. 
 
 

 
 

2

5

4 

3
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You will be navigated to the Completed Reports page where your invoice will be accessible once it has 
been generated in the selected format. Your report appears as Pending or Running while the system 
generates your results. Depending on the size and complexity of the report, it may take a few moments to 
generate the results. Once the report is available, the status changes to Complete.  
 

11. Select Download f rom the Options drop-down menu to view your invoice in the selected format. 
 

 
 

 
The generated invoice will be automatically deleted after seven days. 
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Email Notifications 
 
You will receive email notifications for the following scenarios:  
 

• New Invoice – The purpose of this email is to alert you when new invoices are available for you to 
view. 

• Online Payment – The purpose of this email is to alert you when an online payment has been 
made in Billing & Payments (eBilling). 

• Returned Payment Email – The purpose of this email is to alert you when your payment has been 

returned f rom its bank. 
• Delinquency Email (Warning) – The purpose of this email is to provide notification that your 

account has reached the first stage of delinquency due to unpaid premiums. 
 

Emails will be sent to the email address associated with your Billing & Payments (eBilling) account. 
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Chapter 3 Payments 

Creating and Editing Payment Accounts 

Creating a Payment Account 

Payments may be made by a bank account via ACH transactions. You may enter and store your bank 
account information within Billing & Payments (eBilling) for making invoice payments. You can create 
multiple payment accounts as needed and select different accounts when making invoice payments. See 
Editing Payment Accounts on Invoices for additional information. 

Follow the steps below to create a payment account. 

1. Click the Payments tab on the navigation bar. The Payment Accounts page displays. 

 

2. Click the Create Payment Account button. 

 

 



© 2021 Benefitfocus.com. Inc. 33 

3. Enter the required account information for your bank account. Debit and credit card payments are 
not accepted forms on online payment. 
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4. (If  applicable) Select the checkbox in the Auto-Draft section of the page. When you select to 
enable the auto-draft, an Auto-Draft Authorization Date displays. Auto-draft becomes effective on 
the date authorized. 

 

 

As noted on Payment Accounts page, your account information must be saved before 
5:00 PM on the current invoice due date in order for auto-draft to occur. If the account is 
saved after 5:00 PM on the due date (1st of the month), an on-demand or scheduled 
payment must be made if a payment is due. Auto-draft will not occur until the next 
invoice due date. 

5. Select the Make this my default payment account checkbox in the Account Options section, if you 
want this account to be the default payment account. 

6. (If  applicable) Select Only I can view/edit/use this account for payment option if you want to limit 
the access and use of this payment account to only you. 

7. (If  applicable) Select the Invoice Restrictions tab, if you would like to restrict the account to only 
be used for specific invoices, such as for a particular billing group. 
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Click Save. The account information is saved and a confirmation displays. 

 

 

Editing a Payment Account 

Follow the steps below to edit a payment account. 

1. Click the Payments tab in the main navigation bar. 

2. Click Options and select View/Edit Account for the account to be edited on the Payment Accounts 
page. 
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The Edit Payment Account page displays. 

 

3. Edit the account information as necessary. See Creating a Payment Account for additional 
information. 

 

If  this account is already being used to process payments, you can only change certain 
information, such as account type and auto-draft options. 

4. Click Save. A confirmation displays. 
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Making Payments 
 
Depending on your organization’s configuration and your carrier’s preferences, you may be able to pay 
your bill online and print a pay stub and pay your invoice by mail. The option to pay your invoice can be 
accessed from the home page, the View Invoices page or the Invoice Details pages.  
 

Making Online Invoice Payments 
 
Follow the steps below to make an online invoice payment. 
 

1. Initiate the invoice payment. 
 
Billing and Payments (eBilling) provides three ways to initiate an invoice payment: 

 

• Click the Make a Payment button on the current invoice displayed on the Home page. 
 

 

 
 

• Click Options and select Pay Invoice on the invoice displayed on the View Invoices page (for 
both consolidated and non-consolidated invoices). 
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• Click the Pay invoice button on the Invoice Details page. 
 

 
 
You will be navigated to the payment process page. The top of the page will indicate the current payment 
step followed by the invoice summary for reference. 
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2. (If  applicable) Select Make online payment, then click Next. 
 

 
 

3. (If  applicable) Select the payment account and click Next.  
 

 

 
 

 
If  there is not an account on file, you will be taken directly to the Create Payment Account 
page. Enter your bank account information, click Save and continue to step 4.  
If  you need to edit the existing account or add a new account, see the Editing Payment 
Accounts on Invoice Payment section. 
 

 
If  a default payment account has been selected, this step will be skipped. You can still update 
your account or create a new one by selecting change account on subsequent pages. See 
the Editing Payment Accounts on Invoice Payment section for more information. 
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4. Select the payment amount. Available options will depend on preferences set by your carrier and 
invoice status. Some possible payment options include: 
 

• Total Amount Due – The total amount of the invoice will be paid from the designated account. 

• Balance Forward – The total amount of the past due amount will be paid from the designated 
account. 

• Updated Amount Due – The total amount of the updated amount will be paid from the 
designated account. You may see an updated invoice amount is your invoice was updated 
af ter it was billed such as for a correction. 
 

 
 
 
 

5. Enter a payment date and click Next. 
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All payments made after 2:00 PM EST will be sent to the bank on the following 
business day. 

 
Full payment of premium and interest due must be paid before your group's claims will 
be released for payment. 
 

 
6. Review the payment information. If needed, you can modify the payment using the options in the 

Review and submit section: 

• Click the change account link to modify the payment account. See Editing Payment Accounts 
for additional details. 

• Click the edit payment amount or change payment date links to return to the Choose 
payment options page from which you can modify the payment amount or date. 

• Click the Review invoice payment information details link to display a summary of the current 
payment information. 
 

7. Select the checkbox to agree to the Payment Authorization statement. 
 

8. Click Submit Payment.  

 
 
 
 
 
 
 
 
 
 

 

 

 

8 

7 

6 
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The Payment details page displays. 
 

 
 
The Payment details section also provides several additional features. 
 

• You can print this page to generate a hard copy or save a PDF of the payment for your 
records. 

• Click Review invoice payment information details to display a summary of the current invoice 
details. 
 

 
 

• Click Enable Auto Draft to edit your payment account. See Enabling Auto-Draft Payments for 
more information. 
 

9. Click Return to Home. 
 

Editing Payment Accounts on Invoice Payments 
When editing payment accounts on invoices, you can update the existing account or create a new 
account. 
 

Editing an Existing Account on an Invoice Payment 

 

Follow the steps below to edit an existing account on an invoice payment. 
 

1. Initiate an invoice payment. See Making Online Invoice Payments for additional information. 
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2. (If  applicable) Select Make online payment, then click Next. 

 
 

3. Click the edit account info link. 
 

 
 

 
If  a default payment account has been set, this step will be skipped. You can select 
change account from the Choose payment options page to access the Choose payment 
account page, if needed. 
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4. Edit the account information as necessary. If payments have been made using the account, you 
may be restricted from editing some information.  
 

 
 
If  you have more than one billing group, you can select which group's invoices can be paid with the 
account under the Invoice Restrictions tab. 
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5. Click Save. 
 

Creating a New Account on an Invoice Payment 

 

Follow the steps below to create a new account on an invoice payment. 
 

1. Initiate an invoice payment. See Making Online Invoice Payments for additional information. 
 

2. (If  applicable) Select Make online payment, then click Next. 
 

 
 

3. Select the Create New Account option and then click Next. 
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If  a default payment account has been set, this step will be skipped. You can select 
change account from the Choose payment options page to access the Choose payment 
account page, if needed. 
 

 
 

 
4. Enter the required bank account information. (Credit card and debit card payments are not 

accepted for this configuration.) Required fields are indicated by an asterisk (*). Navigate to 
additional tabs, if necessary. 
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The I wish to keep my payment account information on file for future use checkbox is selected by default. 
Deselect this option if you do not want to store the account information for future payments.  
 

 
 

5. Click Save. The Invoice Information displays the new account. 
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Enabling Auto-Draft Payments 
 
Af ter completing an online payment, you can set up the payment account to automatically draft the 
invoice amount for each due date. When you complete a payment, the Payment details display a 
conf irmation message from which you can enable auto-drafts. (See Making Online Invoice Payments for 
additional information.) 
 
Follow the steps below to enable auto-draft payments. 
 

1. Click Enable Auto Draft in the Payment details section after successfully completing payment. 
 

 
 

2. Select the checkbox in the Auto-Draft section of the Edit Payment Account page. 
 

 
When you select to enable the auto-draft, an Auto-Draft Authorization Date displays. Auto-draft will be 
ef fective the date that it is authorized. 
 

3. Click Save. A confirmation message displays. 
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Printing Payment Stubs for Mailing Payments 
 
Follow the steps below to print payment stubs for mailing payments. 
 

1. Initiate the invoice payment. See Making Online Invoice Payments for additional information. 
 

2. (If  applicable) Select Print payment stub to send in the mail on the Choose payment method page 
and click Next. 

 

 
 
The Print the payment stub page is displayed.  
 

 
 

 
If  you are paying a consolidated bill, you may select the individual invoices to be included in 
the payment. 
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3. Click Next. A PDF of the payment stub is generated. 
 

 
 

4. Print the payment stub and submit to the address on the invoice. 
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Reviewing Payment Account History 

 

Billing & Payments (eBilling) maintains an audit history on all payment accounts. If  your Billing & 
Payments (eBilling) user account is configured with the appropriate permissions, you can view the audit 
history of any payment account. 

The audit history information includes the login ID of the person to make a change to the account, as well 
as the date and time of any changes. 

Follow the steps below to view account history for a payment account. 

1. Select the Payments tab in the navigation bar. 

2. Click Options and select View/Edit Account for the account on the Payment Accounts page. The 
Edit Payment Account page displays. (See Editing a Payment Account for additional information.) 

 

3. Click View History. The Account History window displays. 
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If  applicable, click Advanced Search to search for a specific transaction. Click Reset Search to 
remove the search criteria. 

 

4. Click View for a transaction to view the details. 

The Account History details display. A green checkmark indicates items that were updated for the 
transaction. 
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5. Click view changes resulting from this update at the end of the table to see details about any 
invoice level restriction changes associated with the transaction. 

 

6. Click Back to return to the previous window. 
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Viewing Payment History 
Search for and view payment history to review specific information about payments made to invoices. 

 

A received payment is only tied to an invoice in Billing & Payments (eBilling) if the payment 
was submitted electronically. 

Follow the steps below to view payment history. 

1. Select the Payments tab on the navigation bar. 

2. Select the Payment History tab on the secondary navigation bar. The General Search page for 
payments displays. 

3. Enter the search criteria. 

4. Click Submit to display the search results. 

 

 

1 

 

 

 

4

2
3
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If  necessary, you can use the Advanced Sorting feature to sort the data using multiple 
columns. See Advanced Sorting for additional information. 

 

 

If  a payment has a status of Scheduled, meaning the payment has not been processed yet, you 

may click Options and select Cancel Payment, if needed. Remember to schedule a new 
payment if necessary to avoid a lapse in coverage. 

 

You can view a list of all scheduled payments by clicking the Pending Payments subtab under 
the Payments tab. 
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Chapter 4 Reports 

You can generate invoice and payment reports on the Reports tab. The Reports tab includes three sub 
tabs: 

• The Create Reports tab displays all available reports. Selecting Create for a report will present 
f ilter criteria and format options for the report. You can create a one-time report or schedule 
reports to run at specific time intervals. 

• The Completed Reports tab displays all the reports generated within a specified number of days 
as established for your company. (The number of days is indicated below the list of available 
reports.) 

• The Scheduled Reports tab displays all reports scheduled to run on a specific start and end date. 
You can edit or delete reports from the schedule as necessary. 

Managing Reports 
You can create and schedule invoice and payment reports on the Create Reports tab. 

Creating a Report 

Follow the steps below to create a report. 

1. Select the Reports tab in the navigation bar. The Create Reports page displays. Reports are 
categorized as Invoice Reports or Payment Reports. 
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2. Click Options and select Create for the report to be generated. 

 

3. Enter the report parameters and click Next. Available filters and parameters will vary by report.  

 

 

4. Enter or select the formatting options, including the Report Format (CSV, PDF or HTML) and the 
sorting options. 

 

Because this scenario describes the on-demand report generation process, do not select the 
Run this report on a regular schedule checkbox. See Scheduling Reports for additional 
information. 

5. Click Submit.  
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The Completed Reports page displays. The report Status will display as PENDING or RUNNING 
while generating the results. Depending on the size and complexity of the report, it may take a 
few minutes to generate the results. You can click Refresh Reports to refresh the page and 
display the current status. When the report is complete the Status will display as COMPLETE. 
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The Completed Reports page refreshes automatically every 30 seconds. 

6. Click Options and select Download to download a copy of the report. 

 

The report output downloads and displays. 

 
The generated report will be automatically deleted after seven days. 

 

  



© 2021 Benefitfocus.com. Inc. 60 

Scheduling a Report 

In addition to creating on-demand reports, you can also schedule reports to run at a regular interval, for 
example, once a week or once a month. You can create a schedule for any of the reports available to 
you. 

If  another scheduled report runs during the specified time period for a scheduled report, Billing & 
Payments (eBilling) creates another instance of the report rather than replacing the previously-generated 
report. 

The process for scheduling a report is almost identical to the process of creating an on-demand report, 
but a scheduled report includes some additional parameters. See Creating a Report for additional 
information. 

Complete the following steps to schedule a report. 

1. Select the Reports tab in the main navigation bar, then select Create Reports in the secondary 
navigation, if necessary. 

 

 

2. Click Options and then select Create. 

 

3. Select the f iltering options for your report and click Next. Available options will vary by report. 

4. Select formatting and sorting options for your report. 
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5. Select the Run this report on a regular schedule checkbox on the Report Format page. 

 

6. Enter the scheduling parameters to indicate how frequently you would like to run the report.  

• You must enter a Report Name when setting up a report schedule. 

• If  Day is the selected frequency, you can specify how frequently you want the report to recur 
in days. 
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• When scheduling the report weekly, you can specify which days of the week the report 
generates. 

 

• When scheduling the report monthly, you can specify which day of the month the report 
generates. 

 

7. Click Submit. The Create Reports page displays a confirmation. 
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To view scheduled reports, select the Scheduled Reports tab in the secondary navigation of the Reports 
tab. 

 

The scheduled report displays a Status of Pending until the report generates. The status will then update 
to Complete. After viewing a report, the status updates to Viewed. 

Click the Options menu and select Edit if you would like to update the report schedule or temporarily 
suspend the report schedule. You may instead click the Options menu and select Delete if the report is no 
longer needed. 

 

 



© 2021 Benefitfocus.com. Inc. 64 

 

Sharing a Scheduled Report 

You can copy recurring report criteria to other users. Reports can only be copied to users who have rights 
to the specific report being shared and users who have rights to the groups on the report. Once the report 
criteria has been shared, the user who receives the criteria will see the shared information under their 
Scheduled Reports tab. 

Follow the steps below to share a report schedule with another user. 

1. Create a Scheduled Report. See the Scheduling a Report section for more information. 

2. Select Copy from the Options drop-down menu for the report you want to share on the Scheduled 
Reports tab. 

  

3. Enter the last name of the user with whom you are sharing the report, then click Search. 

  

4. Select the user(s) from the list. 

  

5. Click Copy. 
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Viewing Reports 

You can download and view reports for up to a specified number of days as determined for your company 
af ter the report is generated. Reports are automatically deleted after the specified number of days. The 
number of days is indicated below the table on the Completed Reports and Scheduled Reports tab. 

To view reports, complete the following steps. 

1. Select the Reports tab in the main navigation bar. 

2. Select the Completed Reports tab in the secondary navigation bar. 

 

3. View the status of your reports. 

4. Click Options, then select Download for any report whose status is Complete. 

  

  


